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Il Introduction to the Crude Oil and Natural Gas Tax User Guide

This user guide is intended to help familiarize and provide you with specific instructions for the Crude Oil and Natural
Gas Tax Electronic Data Interchange (EDI) free software, which is provided by the Comptroller’s office.

% What is needed before you begin

Texas Crude Oil and Natural Gas Tax Electronic Data Interchange (EDI) free software.
WebFile Number

Taxpayer Number

Return Information

Bank Information

YVVVYY

+»» About this User Guide

» Button references are formatted in bold (strong) and green.

» Screen names, field names or section names are in italics (emphasis) and green.
» Important warnings are formatted in red and are underlined.

> Buttons and button images are explained in section X1V Button and Icon Legend.



I11 Downloading, Installing and Updating Crude Oil and Natural Gas Tax Software

This section provides instructions for downloading and installing the Crude Oil and Natural Gas Tax Data Entry
software for submitting EDI returns. Warning! If reinstalling the software, save the original database named
Petro40.db to the desktop before continuing.
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Go to https://comptroller.texas.gov/taxes/file-pay/edi/.

Under the Download, Install and Update Free EDI Software, Select the free software link which is
highlighted in blue.

Save the file to your desktop.

Go to your desktop or download folder and double click on the petrofull.exe button.

Select the Next button on the Crude Oil and Natural Gas Tax Data Entry System Setup screen.

Select the Next button on Destination Directory screen.

Select the Finish button.

Delete the petrofull.exe file.

Double click on the Crude Oil and Natural Gas Tax EDI shortcut on your desktop.

If you have a previous version of the Crude Oil and Natural Gas Tax data entry system you will be
prompted to import the data from your prior version of the software.

Select the Yes button when asked if you want to copy information from your old database.

Select Start in the Convert Database screen.

Select the OK button on the pop up when the data has been piped.

Continue to section VI How to Add Taxpayer Information and, Banking Information.

If any leases are not formatted properly a list of these leases will provided in the Natural Gas/Crude Oil
ETF System Migration screen. The list may be printed by selecting the Print button or select the Close
button. All other data should be migrated to the new software.

Once the data has piped from the older version of the software the Status row on the Convert Database
screen should show “Complete.” If an error occurs during migration the Status row will show “Error”
Select the Close button and review data for completeness.




IV Changing the EDI Software Tax Type to Crude Oil or Natural Gas

The EDI software has a Natural Gas Mode and a Crude Oil Mode. The default mode for the software is Natural Gas
Mode. To switch the software tax type modes use the following instructions. All screens within the software must be

closed before changing the tax mode.
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‘State of Texas Comptroller of Public Accounts

Natural Gas

Electronic Tax Filing
Data Entry Program

Verson 4.0 107302014

=

1 Select File from the menu bar.
2 Select Change Tax.

(File] Tools Hep
New b

Open 3

Preload

Exit
3 Select the radio button for Crude Oil or Natural Gas on the Change Tax Type Screen.

Change Tax T | 2 |
£ ype

. Select Tax
" Natural Gas

+ Crude Qil

ok i Cancel ] Help ]

4 Select the OK button.
5 The background image will indicate either Crude Oil Mode or Natural Gas Mode.

aMu B @ @k

State of Texas Comptroller of Public A
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Electronic Tax Filing
Data Entry Program

Version 4.0 1073072014




V' Navigating and Sorting in the Crude Oil and Natural Gas EDI Software

This section will provide some basic information on navigating and sorting all Index screens in the Crude Oil and
Natural Gas Tax Electronic Data Interchange (EDI) free software.

1 Resizing columns

» With any Index screen open.
> Place the cursor arrow on the line which separates the column headers.
» When the cursor changes to the double sided arrow, click and hold the left mouse button down and drag
the mouse left or right.
2 Sorting
> Rows can be sorted in ascending or descending.
» With any Index screen open.
» Click on the column header.
» To reverse the order, simply click the column header again.
» The data is sorted according to the column clicked.
3 Filtering
> Rows can be hidden or filtered out so they do not appear. This is a way to reduce the size of a list so a
particular row or set of rows is easier to locate.
» With any Index screen open.
» Select the View drop-down menu.
> Select Filter.
& Filter =
Original Filker Criteria
Mew Filter Criteria
[N <][nse—=][Tes = e
’S?d Delete
[ ok | Cancel Heln
» Column:
o Select a field. (These are the fields from the Index screen.)
» Operator:
e Choose one of the following values:
i. Equals
ii.  Greater Than
iii.  Less Than
iv. ~ >Than Or Equal
V. < Than Or Equal
vi. Doesn't Equal
> Value:

e Enter the value for the field that you want the search results to show. For example, if you entered
Report Type for the Column, and Equals for the Operator, you could enter 'Original'.
Logical:
e This option can remain blank. If you choose one of these values, a second row of filtering options will
appear. The values are:
i. And
ii. Or



» Select OK button, the Filter screen disappears and the software redisplays the index, populated by those
records that meet the filter criteria.

» To undo the filter, select the View menu.

> Select Filter.

» .Select the OK button. The index screen will reappear containing all of the rows.



VI Taxpayer Account Information

This section provides instructions on adding the basic information regarding Natural Gas and Crude Oil taxpayer
accounts including taxpayer information, banking information, and license types. To request a preload import file, send
an e-mail to EDI.Help@CPA.Texas.Gov with the taxpayer number, tax type, and period.

9 Taxpayer Information [ e

Taxpayer Nbr: |

Taxpayer Name: |

Street: |
City: |
State: |Texas _:_J Zip Code: -

Contact Name: J

Phone Nbr: [ ) - Ext:

Transmitter Nbr: |

Contact Email: |

Route/Transit Nbr: |

Account Type: | R
Bank Account Nbr: |

+ Adding Taxpayer Information

1 Adding the First Taxpayer Record
» The system will prompt users to add the first taxpayer record.

Matural Gas ETF System - Version 4.0

@ Mo entries exist. Create a new ane?

> Select the Yes button to add the first taxpayer.
» Go to step 3 in the Adding Additional Taxpayer Records section.
2 Adding Additional Taxpayer Records

» Select the Taxpayer button.

» Select the New button.

» The Taxpayer Information screen will open.

> Enter Taxpayer Number, Name, Address, City, State and Zip Code.

» Enter contact information including: First and Last Name, Phone Number and Email Address.

» Do not enter the Transmitter Number.

» Enter Route/Transit Number, Account Type (Checking or Savings), and Bank Account Number. The EFT
payment information is optional. Banking information must be entered on this window to include a
payment with a return.

> After entering all data in the appropriate fields, select the Save button located on the menu bar.

» Select the OK button.

> Repeat prior steps as needed for additional taxpayers.


mailto:EDI.Help@CPA.Texas.Gov

* Updating Taxpayer Information

Select the Taxpayer button

Select the row you want to update.
Select the Open button.

Correct information as needed.
Select the Save button.

gk~ wnN -

+» Deleting a Taxpayer

Select the Taxpayer button

Select the row you want to update.

Select the Open button.

Select the Delete button.

Select the Yes button when asked 'Are you sure you want to delete Taxpayer?'
Select the OK button when notified 'Taxpayer deleted.
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VIl  Other Party Information

This section provides instructions on Other Party setup for Crude Oil or Natural Gas. New users will be prompted to
add their first Other Party.

% Adding Other Party Information

1 Adding the First Other Party Record
» The system will prompt users to add the first Other Party record. Select the Yes button

MNatural Gas ETF System - Version 4.0

@ Mo entries exist. Create a new ane?

» Go to number 3 in the Adding an Additional Other Party section.
2 Adding an Additional Other Party
» Select the Other Party button.
» Select the New button.
» The Other Party Information screen will open:
DelE| &8 | X | e

B other Party Information

Other Party Nbr: | T t

Other Party Name: |

Enter the Taxpayer Number of the Other Party.

Enter the Name of the Other Party.

Select Save button and close the Other Party Information screen.
Repeat previous steps for additional Other Parties

VVVY

+« Updating Other Party Information

1 Select the Other Party button.
2 Select the Other Party to be updated.
3 Select the Open button.
4 Changing the Other Party Name.
» Select the Other Party Name field.
» Update the Other Party Name.
» Select the Save button
5 Taxpayer Number Change.
Select the Change Number button.
Enter the new taxpayer number.
Select the Save button.
If the Change Number button is use, when saved, a new Lease Setup is created for every existing lease
set up in which the old other party number is used.

YV VY



s Deleting Other Party Information

Select the Other Party button.

Select the Other Party to be deleted. You cannot delete an Other Party that has been used in a return.
Select the Delete button

Select the Yes button when asked 'Are you sure you want to delete Other Party?'

Select the OK button when notified 'Other Party deleted.

gk~ wnN -
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VIIlI  Adding Leases and Lease Setups

This section provides instructions on adding lease and lease setup. New users will be prompted to add the first lease
setup record.

% Adding a Natural Gas Lease
1 Add the First Natural Gas Lease

2

» Select the Lease Setup button.
> Select the New button.
» The system will prompt users to add the first Lease record. Select the Yes button.

MNatural Gas ETF System - Version 4.0

@ Mo entries exist. Create a new one?

Yes No |

» Continue to the third bullet in the Adding an Additional Natural Gas Lease section.

Adding an Additional Natural Gas Leases

» Select the Lease Setup button.

» Select the New button.

» The Add new Lease and First Lease Setup screen will open:

wJi. Add New Lease And First Lease Setup

Lease ID: Lease List... Lease Status:
Lease Type: [ ] Type Nbr:

County of Production: | | County Nbr:

RRC Lease Number:

Drilling Permit Number? ° Yes® No

Lease Name: |
Setup Status: m
Exemption: | | Liable for Tax: © Yes © No
Commodity: | - Off Lease Sale: © Yes ° No
APl Nbr: Tax Reimbursement: * Yes ' No
Taxpayer Nbr: ]— Taxpayer Lookup... ‘
Other Party Nbr: Other Party Lookup.. |
Avg NG Price: Lease Type 5 Tax Rate:

» Select the Lease Type drop-down button to display values and choose Oil Lease or Gas Lease.

> Enter the county name in the County of Production field or select the County of Production drop-down
button to display a list of 254 counties in Texas and make a selection.

> Enter the Railroad Commission (RRC) Lease Number into the Lease Number field.

e Gas Lease: Enter the six-digit number which was assigned by the Railroad Commission.

e Oil Lease: Enter a zero and then the five-digit number assigned by the Railroad Commission.

e If no lease number has been assigned, enter the six-digit drilling permit number assigned by the
Railroad Commission. The drilling permit number is a temporary fix until the lease number is
assigned by the Railroad Commission.

» Select Yes or No to the Drilling Permit Number question.
» Enter the lease name into the Lease Name field.

11
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The Setup Status field is automatically set to Active.

Select the Exemption Type drop-down button to display a list of exemption types.

Select the exemption type for the lease.

If the lease has no exemption, select 0 No Exemption.

Select the Commodity drop-down button to display the list of commodities. Select the appropriate
Commodity Code.

Select Yes or No to Liable for Tax.

Select Yes or No to Off Lease Sale.

Select Yes or No to Tax Reimbursement.

Enter the API number in the API Number Field if applicable.

Select the Taxpayer Lookup button to see the taxpayer list.

Select the taxpayer number from the Taxpayer Lookup index and select the OK button.

Select the Other Party Lookup button to see the other party list.

Select the Other Party Number from Other Party Lookup index and select the OK button.

For exemption type 11 only: Select the AVG NG Price drop-down button and choose the appropriate
average price, if applicable.

For exemption type 5 only: Enter the Reduced Tax Rate in the lease Type 5 Tax Rate field.

Select the Save button.

% Adding a Crude Oil Lease

The section provides instructions on adding a new Crude Oil lease. New users will be prompted to enter their first
Crude Oil lease.

1 Adding the First Crude Oil Lease

>
>
>

>

Select the Lease Setup button.
Select the New button.
The system will prompt users to add the first lease record. Select the Yes button

F N
Crude Oil ETF System - Version 4.(‘
L, o
Q Mo entries exist. Create a new one?
Yes Mo ‘

Continue to the third bullet in the Adding an Additional Natural Gas Lease section.

12



2 Adding Additional Crude Oil Leases

>
>

YV VYV
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Select the Lease button.
The Add new Lease and First Setup screen will open:

L=an= Ly I Lot Limr J Leasm Siatum
Lense Type: | =] T
County of Production: - oty WE
RRAC Lease Mumber:
Dirillimg Parmit Number? Yem MNo
Lease Mame:

Selup Status: [Active -

Exemptian: - Liabie for Tax; Yes  No
Commadity: = Off Lepse Sale:  Yes No

AP Pt Tax Relmburssmemnt: Yes  No
Taxpayer Hor: | T uepaiipisl Liwiboafi
Dither Party Nbr ._-'_1.-¢l're-"\. Lookap

Select the New button.

Enter the County Name in the County of Production field or select the County of Production drop-
down button to display a list of 254 counties in Texas and make a selection.

Enter the Railroad Commission (RRC) provided lease number into the Lease Number field.

Oil Lease: Enter a zero and then the five-digit number assigned by the Railroad Commission.

If no lease number has been assigned, enter the six-digit drilling permit number assigned by the Railroad
Commission. The drilling permit number is a temporary fix until the lease number is assigned by the
Railroad Commission.

Select Yes or No to the Drilling Permit Number question.

Enter the lease name into the Lease Name field.

Select the Exemption Type drop-down button to display a list of exemption types.

Select the exemption for the lease

If no exemption on the lease, select 0 No Exemption.

Select the EOR drop-down button to choose Baseline production or Incremental production, if
applicable.

Select the Yes or No radio button for the Lease Operator question.

Select Yes or No radio button for the Liable for Tax question.

Enter the API number in the API Number field if applicable.

Select the Taxpayer Lookup button to see a list of taxpayer added in the software by the user in
previous steps.

Select the taxpayer number from the Taxpayer Lookup index and select the OK button.

Select the Other Party Lookup button to see the other party list.

Select the other party from Other Party Lookup index and select the OK button.

For exemption type 11 only: Select the AVG CO Price drop-down button and choose the appropriate
average price, if applicable.

Select the Save button.

13



* Adding Leases after a Return Has Been Started

Go to the Adding a Natural Gas Lease or Adding a Crude Oil Lease section.
Once completed select the Report button

Double-click the desired report.

Select the Active Setups Tab.

Double-click the new lease.

The new lease will appear on the Lease Detail tab.

~NoO ok, wWwN -

% Updating Lease information

1 Select the Lease button

2 Double click the lease to update.

3 Update the lease information as needed.
4 Select the Save button

¢ Deleting Leases

Select the Lease button

Double click the lease to be deleted.

Select the Delete button.

Select the Yes button when asked 'Are you sure you want to delete Lease?'
Select the OK button when notified 'Record deleted.’

g~ wdNPE-

% Adding a Lease Setup
DE @8 | X |44 > B0

Close the Report screen. When indicated select the Save button to save the report.

;:m Add New Lease And First Lease Setup

Lease 1D: Lease List,. I Lease Status:
Lease Type: Eil Lease Type Nbr: 1
County of Production: | ~| County Nbr:

RRC Lease Number:
Drilling Permit Number? { Yes { No
Lease Name: |

Setup Status: |Active  ~| Lease Operator: © Yes © No
Exemption: | =~ Liable for Tax: © Yes 7 No
Expanded EOR: |Not Applicable |
API Nbr:
Taxpayer Nbr: r—————"__" Taxpayer Lookup... |
Other Party Nbr: [ Other Party Lookup... |
Avg CO Price: Pct Net Txbl Reduced:

[

Select the Lease Setup button.
Select the New button.
3 Select the Lease List button.
» The Lease List screen will open.
e If the lease number you need is shown in the screen:
I.  Select the lease
ii.  Select the OK button.
e If the lease you need is not shown in the Lease List screen:
I.  Select the New button.
ii.  Enter the new lease information
iii.  Select the Save button.
4 The Setup Status field is automatically set to Active.

N

14



10

11

12

13

14

15
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17
18

» To change it to inactive, select the Status Setup drop-down button and, select Inactive.
The Exemption field is automatically blank.
» To add an exemption, select the Exemption drop-down button to display a list of exemption types.
> Select the appropriate exemption for the lease you are setting up. If no exemption for the lease, select 0
No Exemption.
Commodity, Natural Gas Only:
> select the Commodity drop-down button to display the list of commodities. Select the appropriate
commodity code.
Expanded EOR, Crude Oil Only, if applicable:
> select Expanded EOR drop-down button to choose Baseline or Incremental production.
API Nbr:
> This field is required if setting up an oil lease with an exemption of 2-year Inactive (natural gas and
crude oil), 3-year Inactive (natural gas and crude oil), TERRA (crude oil only), Orphaned Wells (natural
gas and crude oil) and Enhanced Efficiency (crude oil only).
Lease Operator, Crude Oil Only:
> Select either Yes or No to indicate whether or not you are the lease operator.
Liable For Tax:
> Select either Yes or No to indicate whether or not you are liable for tax for this lease.
Off Lease Sale, Natural Gas Only:
> Select either Yes or No to indicate whether or not the production is off lease delivery for this lease.
Tax Reimbursement, Natural Gas Only:
» Select either Yes or No to indicate whether or not there is tax reimbursement for this lease.
Taxpayer Nbr:
> Select the Taxpayer Lookup button to see a list of taxpayers from which to choose.
» Choose the taxpayer for this lease.
» Select the OK button.
> If the taxpayer is not in the list:
e Select the New button to add a new taxpayer.
e Enter taxpayer information.
e Select the Save button.
e The new taxpayer number will fill in the Taxpayer Nbr field.
Other Party Nbr:
» Select the Other Party Lookup button to see a list of other parties from which to choose.
» Choose the other party for this lease.
» Select the OK button.
> If the other party is not in the list:
e Select the New button to add a new other party.
e Enter the new other party information.
e Select the Save button.
e The new other party number will fill in the Other Party Nbr field.
Avg NG Price (natural gas) or Avg CO Price (crude oil):
» This field is required when setting up a Low-Production lease exemption. Select the arrow to the right of
the field and choose the appropriate price range.
Lease Type 5 Tax Rate, Natural Gas Only:
> If setting up a High-Cost 5 exemption, enter the reduced tax rate in the Lease Type 5 Tax Rate field.
Select the Save button.
If you want to set up another lease select the New button.

15



* Updating Lease Setups

1

2
3
4

5

Select the Lease Setup button.

Select the row you want to update.

Select the Open button.

Make Changes to the lease setup as needed.

» Changes to a lease setup are limited to:

Setup Status

Liable for Tax

Tax Reimbursement

Avg NG Price (Natural Gas Low- Producing Exemption)
Avg CO Price (Crude Oil Low-Producing Exemption)

I.  Prior to beginning an original report, the Avg NG or CO Price on a Low-Producing Type 11
Exemption should be set to the correct range for that period. If you have multiple Low-Producing
Type 11 Exemptions in the Lease Setups Index you will be asked if you want to update all to the
price range you have chosen. Select the Yes button to change all Low-Producing Type 11
Exemption lease setups to the price range you have chosen.

Matural Gas ETF Systemn - Version 4.0 28

@ ~ \ There are multiple lease setup records found for type 11 exempt leases.
& Would you like to update the Avg NG Price to "over 53.00 to 53.50" for
~ all records?

e Lease Type 5 Tax Rate
Select the Save button.

¢ Deleting Lease Setups

1
2

o Ol bk W

Select the Lease Setup button

Select the row you want to delete by clicking on it

> A Lease Setup that has been used in a report cannot be deleted unless, the report is deleted first.
Select the Open button

Select the Delete button

Select the Yes button when asked 'Are you sure you want to delete this Lease Setup?'

Select the OK button when notified 'Lease Setup deleted.’

16



IX Creating a Report

This section provides instructions for creating an original or amended report for processing and filing.

 Opening a New Report

A OwLODN P

o o1

7
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Matural Gas Report

Header lSummary l [Cease [eta] l IFdlew l Aictive Setips l

Report Type: © Original © Amended  1ibr: 0 Period:|  0000/00

FilingType: | Status: Unprocessed
Taxpayer Nbr: hd

Final Report?—————— 1~ Zero Report?
{ [l Last Date: /00/00/0000 { | —‘

Add Lease Detail

Select the Report button.
Select the New button. The Header Tab will open.
Select Original or Amended for the Report Type.

Enter the period for which are filing in the Period field. Enter the period in YYYY/MM format. For

example 2016/10, represents the October 2016 reporting period.
Select the Filing Type drop-down button and select the type of report.

Select the Taxpayer Number drop-down button and select the taxpayer number.
Select the Add Lease Detail button.

¢ Entering Lease Data

1

Natural Gas

eH @8 X g ppi @S

Matural Gas Report Test Oil & Gas Company (12345678903) 2014/10  Ornginal Producer
Header | Summary Lease Detail tindex I Active Setups
Other Party: 12012345679 Test Operating Company

Lease 10: 2.031.234567 Flor D'Luna 1 Drig Permit: No
Commeodity: RG1 Raw Gas Liable for Tax: Yes
Exemption: No Exemption APl Number: Tax Reim: No

Total Lease Volume: 1,001

Your Volume: 1,001 Value of Volume: $25,000.00
Govt Exempt Volume: 0 Exempt Value: $0.00

Marketing Costs: $0.00

Net Taxable Value: $25,000.00

] Tax Rate: x 075000 TaxDue: $1,875.00

Met Taxable Fee Volume: 1,001 x .000667 Regulatory Fee: $0.67
Net Amount Due: $1,875.67

Row 1 of 1

» The Lease Detail Tab will open.

Volume, Exempt Value, and Marketing Costs. When creating an amended report the Net Taxable Value

must be manually entered.

> Select the Next button to access the next lease.
> Select the Save button at any time to save the report.

> Review the return data by selecting the Index tab.

17
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Review all leases entered and available for reporting on the Active Setups tab. Only the leases entered on

the report are checked.

> Select any leases that need to be added to the report.
e To select one lease, double-click on the lease.
e To select all of the remaining leases: Select the first unchecked lease, press and hold the Shift key on
the keyboard, then select the last lease on the list.
e Select the Apply Lease Detail button.
2 Crude Oil
el &8 X M« ppigid
EH Crude Ol Report Test Oil & Gas Company (12345678903) 2014/10  Original Purchaser
Header i Summary Lease Detail ]Index | Active Setups
Other Party: 12012345679 Test Operating Company
Lease [0: 1-108-012345 Reddick 1 Drlg Permit: No
sanded EOH: Not Applicable Liable for Tax: Yes
Exemption: No Exemption API Number: Tax Reim: No
API Gravity: | 41.3
Gross Barrels: 1,001 Gross Value: $25,000.00
Exempt Barrels: 0 Exempt Value: $0.00
Trucking Costs: $0.00
Net Taxable Value: $25,000.00
Tax Rate: x .046 TaxDue: $1,150.00
Taxable Barrels: 1,000 x .008125  Regulatory Fee: $8.13
Net Amount Due: $1,158.13
» The Lease Detail tab will open.
> Enter API Gravity, Gross Barrels, Gross Value, Exempt Barrels, Exempt Value and Trucking Cost for
that lease. When creating an amended report the Net Taxable Value must be entered manually.
> Select the Next button to access the next lease.
» Select the Save button at any time to save the report.
> Review the return data by selecting the Index tab.
> Review all leases entered and available for reporting on the Active Setups tab. Only the leases entered on
the report are checked.
» Select any leases that need to be added to the report.

e To select one lease, double-click on the lease.
e To select all of the remaining leases: Select the first unchecked lease, press and hold the Shift key on
the keyboard, then select the last lease on the list.

e Select the Apply Lease Detail button.

18



¢ Importing Lease Detail

The import feature is a time saving function which allows you to import volume/value figures into a report using a tab-

delimited text file instead of entering it manually on the Lease Detail tab in the Activity Report window

1 Creating an Import File
> Open Microsoft Excel.
» Select File, Open from the Excel menu.

> Locate the folder in which the application was installed.

Typically, this is: C:\ProgramData\TexasCPA\Petro40\.

» Select the Excel file petroimport.xlsx and select the Open button.

File name: petroimport.xlsx

-~ 4

L}

Open |§3|
..« ProgramData » TexasCPA » Petrod0 » w | +4 W Scarch Petrodd pel
Organize » Mew folder B | '@:'
. Microsoft Help - MNarme 2 Date modifie *
B Ml o | Testfiles 4/23/2014 31
. Metwork Associates @J coimport test.ds 6/5/2013 10:45
8¢ NVIDIA ] @J co import testadsx 6/5/2013 10:5;
1 NVIDIA Corporation T PR 7/18/2014 lU
. Package Cach-e [Z] & petroimport_multi_reports.xls 7/18/2014 miE
PG? Corporation : =: E‘J Preloadlease.xlsx 771872014 lll
.. regid.1991-06.com.microsoft IZH Pl St e 7/18/2014 ll
|\ Scalable Software ) PreloadOtherParty sk 7/18/2014 11]
B SOL Angwhese 17 @ PreloadTaxpayer.xlsx 7/18/2014 ll
- 1eeston ] test import Lads 6/5/20139:17
o Tad ) test import 1113adsx 11/13/2014 8
W Betrod) () test multi import.dsx 6/5/2013 9:54 ~
L Staxb r

3

v Al Excel Files ("o ads” sy ~ |

Tools - I Open

) |

Cancel ]

> Instructions and examples appear on lines 1 through 10 of the spreadsheet. Read the instructions
carefully and then enter YOUR information beginning in Column A Line 11.

[ ]
amending.

For Original reports you must enter a value for each column from A to P. You must enter Q if

Commedite. (€ APL Tetnl Lanse Volume | Volum
4 TypeCode |TypeMbe [Lease Type |Cownty L] ion [Mumber iLeose ipti )
5 RS i 7 1]_12345] [0t i the Bocrsss 81
6 RO i El 100] Z1455T] 0| Timbuitu #17
] 3 2 789
8 CN 4 1 456|
3 RS 5 I T226TEN0]

0 ] 55| 745678 U[East Tenas Aligator #5

Feady

4
T A e =

» When all of your data has been entered, select rows 1 through 10 by holding down the 'Ctrl' key and
selecting each row number. You MUST select the row number in order to highlight the ENTIRE row.
Select Edit, Delete from the menu. This will completely delete all the instructions and example data
leaving only the data you entered.

» Your data should now start on row 1.

>
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>

>

>
>

Select File, Save As from the menu.
e Do NOT select Save or click the save icon on the toolbar. If you use Save instead of Save As, you
will overwrite the example spreadsheet and won't be able to use it in the future.

[#] save As =]
| » Computer » Local Disk () b ProgramData » TexasCPA b Petrodd v|«;,,I Search Petrod0 2
Organize = New folder EE= @
Mchfee < Mame Date modified i S
Microsoft - e .
[ import201409.6¢ 12/1/20141210PM  Text Document 1KB
|| Microsoft Help : = z
i [ connectiog.tt 12/1/201410:58 AM  Text Document 2KB
oo [ T201401NGOTest one.txt 3/20/2014 1010 AM  Text Document 28
Package Cache
i [ testimportt 3/7/20141204 PM  Text Document 1k8
PGP Corporation S B
[ T201312NG0.0¢ 3/7/2014935AM  TextDocument 1KB
I\ regid.1991-06.com.microsoft ; s 3
. [ &) preloadcontinentaltxt 2/24/2014 1204 PM  Text Document Iv]
] 12|
e = 4 preloadbasspetroltt 2/24/201411:52 AM  Text Document EL]
Scalable Software |
i SQL Anywhere 12
I szcap
|| TexasCPA
a3
| Tt
Motorfuelss
Petrod0
Staxt - T —— i I
File name:  import201409.6¢ .
Save as type: | Text (Tab delimited) (*:od) -

Enter a DIFFERENT file name in the File Name field, such as 'import201403.txt". (It's a good idea to
use the period in the file name since it will help you identify multiple import files later.)

Change the value in the Save as type field to Text (Tab delimited) (*.txt).

Click the Save button.

Importing Report Data

VVVVYY

Open the Crude Oil and Natural Gas Tax Electronic Data Interchange (EDI) free software.
Create a new report. Go to chapter XII Creating a Report for more information.

Select the Lease Detail tab.

Select on the Import button.

Select the tab-delimited text file you just created, ex. 'import201403.txt' and

Select the Save button.

ﬂScIcct[mpm Data File &5
Savein: | |, PETRO ~| « & cF B
Mame Date modified -

| import201400.b4 12/1/2014 11:55 AM

| preload test companylt.bd 12/1/2014 10:32 AM

3 | preloadpetropoint.be 127172004 10:33 AM

4 | preloadurband’.producer b 10724,/ 2014 8:39 AM

A | preloadoxyusa.txt 10/10/2014 1:24 PM =
a m [
File name [impont b Save
Save astype: |TXT Fles (. TXT) | Cancel I

The data from the import file will now appear on the Lease Detail tab. Use the buttons to scroll through

the lease setups and check to see if the import was successful. Make sure ALL of your lease setups were

imported and that the values are correct.

Select the Save button.

e The import process does NOT save. Select the Save button after importing to keep your work. The
Index tab does NOT display imported data until it is saved.

If an error message appears, something is wrong with the tab delimited text file. Read the error messages

closely, and to the Things to Look for If Your Import Fails section.
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3 Things to Look for If Your Import Fails

>
>

Is the data entered in ALL the cells from column A through P (Q if amending) and for ALL rows?

Did you enter the right values for commodity type, product type, and county? These values must match

the predefined codes in the system. If you are unsure about what the value should be, open a window

which contains a drop down of the values in which you are interested.

e For example, open the Lease Index screen, select the New button, and select the County drop-down
button to see a list of valid values for counties.

Are your figures the right number of digits or characters? The top of the spreadsheet indicates the

maximum number of digits or characters a value can be. For example, Other Party Name must be 60

characters or less. If you entered 61, an error would occur.

Do the lease, lease setup, and other party already exist in your database? If you haven't created a lease,

lease setup, and other party before trying to import data for that particular lease setup the import will

fail.

Did you delete the instructions and example data from the spreadsheet before saving as a tab-delimited

file? The import function is expecting only YOUR data to be in the file.
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 Importing Multiple Activity Reports
The Import Multiple Reports feature is a time saving function which allows you to import volume/value figures into a
report using a tab-delimited text file instead of entering them manually through the Activity Report window. This
feature goes a step further than the single import in that it creates both the Activity Report and the accompanying Lease
Details.
1 Creating an Import File
» When the software is installed, a directory named Petro40 is created in one of the following directories:
e C:\ProgramData\TexasCPA\Petro40 for Windows 7 and 8
e C:\Documents Settings\TexasCPA\Petro40 for Windows XP and others.

@Uﬂ | v Computer » Local Disk (C:) » ProgramData » TexasCPA » Petrodd »

File Edit WView Tools Help
Organize « Include in library - Share with - Burn MNew folder
J Program Files (x86) - MName Date modified
. ProgramData E] petroimport.xdsx 2/13/2015 12:26 PM
. Adobe & petroimport_multi_reparts.xds 7/18/2014 9:49 AM
. Apple ] Preloadl ease.xlsx 7/18/2014 10:04 AM
. BlueZane (E] Preloadl easeSetup.lsx 7/18/2014 10:04 AM
. Hyland (] PreloadOtherParty.xlsx 7/18/2014 10:04 AM
. Intel (E] PreloadTaxpayeradsx 7/18/2014 10:05 AM

» This directory includes an Excel file named petroimport_multi_reports.xIsx. This file provides the
template for the column order and column formats needed for data that you wish to import into the
software. It also describes whether data is required or optional. Companies who extract data from
another accounting systems could utilize this layout and could have the extracted data formatted to meet
the template requirements. In addition data such as taxpayers, other taxpayers, leases and lease setups
must exist in the software before report data imports will be successful.

Formutas

Data Review View

Insert Page Layout

TR " AN - SR wirap Text Text - =) B i E avtosum - A ;
p_. G- A = v ) P =B t{d ﬁ;{ e 1 &) Fin- S};I’ FL}&
aste - - Oy - - i=iE Sl A v - - o £l -5 op onditional Format Cell mat ort & Find &
¢ EIZ0- B- 0 A EXW FE Bt~ S - % % Formatting - as Table - Styles~ - - - ZCear~  Fimers Select~
- Alignment . Jumber g Styles ce Editing
A3 - S | Lines 1 through 15 MUST BE DELETED BEFORE SAVING THIS SPREADSHEET AS A TAB-DELIMITED .TXT FILE. Import will fail otherwise. Do NOT SAVE = b
A B c D E F G H 1 J K L M N
1 Eetro Multiple
1 character. (Vakd Texs
Vald Texas Mnthly T characters. & digitsino tacpayer n
taxpayer Producer = |Must be vald |2 characters. 1 character. dash). If no (11 digits, |
number. (11 1 character | T, Methly Fiing Period. |Wustbe vaid  |Mustbevaid |1t Mustbe |3 digts. Must it ea APt start with |
digts, must start |3 characters. ‘O'niginal or | Purchaser = |mot prior 8o type wvakd lease type  |be valkd Texas exemption, Nuembeer, if Off-Leas
2 wihier3)  [GaSoron [amensed [ 195001 code type number. |(0d = 1. Gas = 2). |county code. |6 diges. [load with 0 |load with 0 |80 characters of less iead vith 0
Lines 1
through 15
MUST BE
DELETED
BEFORE
SAVING THIS
SPREADSHEET
AS A TAB-
DELIMITED
TXT FILE.
Import will fad
otherwise. Do
HOT SAVE
CHANGES TO
SPREADSHEET
3 USE SAVE-AS
Repart  |Filing
Report Tax |Report  |Eiling.  |Peri Commaodity. |Commaodity | AP
4 Taxpayer ID |T: Type Type YYYY/MM (1 Type Code [T Nbr |Lease Type |County RRC # mption |Number |Lease Description OQther Pz
5 12345678901 GA: [+] [+] 2006101 RG 1 1 1] 12345 0]Out in the Boonies #1 123456
6 _12345678901|GA: [+] D 2006001 LU 3 55| 723456 0] Over There
T 12345678901 GA A D 2006001 RG 1 5678 0]Out in the Boonias #1 12345€
B 12345678901 GA. A D 2006001 LU 3 E 456 0)Over There
9 12345675901 GA: A D 2006101 CH 4 203 234567 11 0]Panhandle #3 J2145€
10 12345678901 GA. A 1] 12006101 RS 5 T2| 256789 [1 0]South Texas Big Game 247 1058TE »
M« v M| petroimportxls . £J. 1 O D L3
Ready EHom wes = +

» The data which conforms to the layout of the petroimport_multi_reports.xlsx Excel file must be saved as
a tab-delimited text file (with extension of .txt) in order for it to be imported into the software.
2 Importing Multiple Activity Reports
» Select Tools, Import Multiple Reports from the main menu.
» Select the Import button.
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3

» The Select Multi-Report Data File screen will open.

>
>

>

Select the properly formatted tab-delimited .txt file that you want to import.

Select the Save button.

e |If Activity Reports from the file are successfully processed, a popup screen will be displayed that
shows the key fields for the report.

e There will also be a messages display.

B Hotual Gas ETF Syster - Version 4.0

Lo B i@ & B
IR Iepont Multiple Actity Repoets

|| Mercages
| |[Mo Setup found: TP 12HEATEWS Cmadr: 1 Exma: 0 Cney 4 ARC: 923165 LeaaTy: T OshrPray: 0 AP0
|

|t of Public Accounts

=

Zgtivity Repart Detsil Rows ety
0 1 o inchuded for Report - o
TR-ID: 12345678903 as
Swve Messages | :L'?:j]mam.
| | Failed Ienparnt Dats ::’ %-\s
| || Taxpayer I1d Report Tax Type Report Type Ruport Filing Type Filing Pd)| i
| 1| 12345678903 GAS A o 2013002 )
| || Rows: 1 ok !
| Electronic Tax Filing
Data Entry Program
Version 4.0 10302014

| Save Failed Import Rows

[_mport_ __Close_|

I
i.  The Messages display gives feedback on both successful and failed import data. The Failed
Import Data captures each row that has errors.
ii.  The Import Complete screen is displayed and it explains that both the Messages display and the
Failed Import Data can be saved as Excel spreadsheets for later viewing.
If an error message appears, something is wrong with the tab delimited text file. Read the error messages
closely, and to the Things to Look for If Your Import Fails section.

Things to Look for If Your Import Fails

>
>

Is the data entered in ALL the cells from column A through U (V if amending) and for ALL rows?
Did you enter the right values for commodity type, product type, and county? These values must match
the predefined codes in the system. If you are unsure about what the value should be, open a window
which contains a drop down of the values in which you are interested. For example, open the Lease
Index screen, select the New button, and select the County drop-down button to see a list of valid values
for counties.

Are your figures the right number of digits or characters? The top of the spreadsheet indicates the
maximum number of digits or characters a value can be. For example, Other Party Name must 60
characters or less. If you entered 61, an error would occur.

Do the lease, lease setup, and other party already exist in your database? If you haven't created a lease,
lease setup, and other party before trying to import data for that particular lease setup the import will
fail.

Did you delete the instructions and example data from the spreadsheet before saving as a tab-delimited
file? The import function is expecting only YOUR data to be in the file.
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¢ Updating and Deleting Reports
1 Updating a Report

2

YVYVYYVYYV

Select the Report button.

Select the row you want to update by clicking on it.

Select the Open button.

Select the Lease Detail tab.

Update the Lease Detail information as needed.

e To change information on a particular lease setup, locate it using one of the following techniques:
I.  On the Lease Detalil tab, scroll through the lease setups via the Next and Prior buttons.
ii.  Select the Index tab, locate the lease setup, and double click on it.

o |f the lease setup is not yet included on the report:
I.  Select the Active Setups tab, locate the lease setup, and double click on it or,
ii.  Select the lease setup and click on the Apply Lease Detail button.

e Deleting Lease Setups:
I.  Select the Lease Detail tab, locate the lease setup to delete, and select the Delete button.
ii.  Select the Yes button when asked 'Are you sure you want to delete Lease Detail?'

1. The deletion of lease setups from a report is unlike deleting other information in the
application. You must manually save the deletion of lease setups from the report. Most other
deletions are saved automatically.

Click the Save button.

After entering data for all your leases, it is important to validate the system-computed figures against

your own. To do this:

e Select the Summary tab for a display of the totals for all lease entries.

e The Index tab for a spreadsheet view of every lease setup that you are reporting and the figures for
each.

e If necessary, correct any errors by returning to the Lease Detail tab and entering the correct data in
the appropriate fields.

e Select the Save button.

Deleting a Report

VVVVY

Y VY

Select the Report button.

Select the row you want to delete by clicking on it.

Select the Open button.

Select the Header tab.

Select the Delete button.

e This will delete THE ENTIRE REPORT.

e |f the Lease Detail tab is active, selecting the delete button will delete the LEASE SETUP displayed
from the report.

Select the Yes button when asked, 'Are you sure you want to delete Activity Report?'

Select OK button when notified, 'Report deleted.'
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X Entering Payments and Penalties

This section provides instructions for entering penalties and payment that will be include with the EDI return. The EFT
payment date or settlement date is the date on which the funds will be withdrawn. To receive the allowance for
handling discount, the EFT payment date must be no later than the due date of the report, and the report payment file
must be transmitted by 2:30pm (CT) on the business day before the due date. Please refer to the due date chart for EFT
payment in the Texnet Bookilet.

¢ Electronic Funds Transfer (EFT)

1 If you are using Electronic Funds Transfer (EFT) to pay taxes, complete the following:

You must enter bank account data on the Taxpayer Information screen in order to use this feature.

Select the Report button.

Select the Summary Tab.

Enter EFT Payment information in the Payment Amount field.

Enter any previous payments for the period. Credits from other periods may be verified by calling the

Comptroller’s Office for verification.

Enter Penalty and Interest amounts if the report is late and penalty and/or interest are due.

Enter the date on which the money is to be withdrawn from your account in the EFT Payment Date

field. This date must be at least 1 day in the future, but no more than 30 days.

e Filing Deadline - Timeliness of Payment

i.  Inorder for a tax return with a payment to be considered timely, it must be transmitted to the

Comptroller and then processed successfully by 2:30pm (CT) the bank business day before the
due date. When a due date falls on a weekend or holiday, it is important to transmit your return
no later than the bank business day before the weekend or holiday. For example, if the due date
falls on a Monday (or Tuesday, if Monday is a banking holiday), the return must be transmitted
no later than 2:30pm (CT) the previous Friday. If your payment is received after 2:30pm (CT) it
will not be processed until the following bank business day and will be considered late.

Select the Save button.

Close the Report screen.

Continue to Processing (Saving) Returns for Submission.

VVVVY

Y VY

YV VYV
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XI Amending a Report

This section will provide guidance on amending crude oil and natural gas reports that have already been processed and
transmitted to the Texas Comptroller of Public Accounts.

% Creating an Amended Report

1

2
3
4

\l

10
11

Select the Report button.
Select the New button.
Select the Amended radio button in the Report Type field.
Select the Filing Type drop-down button.
> Select the same value as the original report.
Select the Taxpayer Nbr drop-down button.
> Select the same taxpayer as the original report.
Enter the same period as the original report in the Period field.
Select the Save or Add Lease Detail button.
Update the Lease Detail information as needed.
> Enter the DIFFERENCE between the value originally reported and the desired value.
e For example, if you originally reported $200 for Value of Volume but the correct amount should be
$300, enter $100 in the amended report.
To change information on a particular lease setup, locate it using one of the following techniques:
» On the Lease Detall tab,
e Scroll through the lease setups via the Next and Prior buttons.
e Select the Index tab, locate the lease setup, and double click on it.
> If the lease setup is not yet included on the report,
e Select the Active Setups tab, locate the lease setup, and double click on it or,
e Select the lease and click the Apply Lease Detail button.
Select the Save button.
After entering data for all your leases, it is important to validate the system-computed figures against your
own. To do this:
» Select the Summary tab for a display of the totals for all leases entered.
> Select the Index tab for a spreadsheet view of every lease setup that you are reporting, and the figures for
each.
> If necessary, correct any errors by returning to the Lease Detail tab and entering the correct data in the
appropriate fields.
» Select the Save button.
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Xl Processing (Saving) Returns for Submission

This section provides instructions for Processing (Saving) Returns for Submission to the Comptroller’s Office. A
Production file may only be submitted after completing the Registration and Enrollment Process. \Warning! Reporting
of EDI files has not been completed until receipt of a confirmation email from the Comptroller’s office with a Status of

“Passed.”

ﬂ Matural Gas ETF SH— WVersi
—
IFiIe Tools Options  Window  Help
lleBL o=@ @
(D& E& a4 (S|

Reportindes eo ==
Taxpayer # Taxpayer Name Period | Report Ty Amnd Nbr Status Rpt Filg Ty EDI File Name Confirmation # Envelope File Name |

12345678303 _Test 0il & Gas Company _ 7H2015 Original 0 Unprocessed Wonthly Purchaser |

Data Filter
EDIFile Created

o All " Processed & Unprocessed

Ready

¢ Processing a Single Return

1
2

o1

~

From the Report Index screen, highlight the file to be processed and select the Create EDI File button.

A notification box confirming processing of the return. Alternations will not be allowed after processing.

» If everything is correct, select the Yes button.

» To change the information, select the No button and return to the Report Summary screen to make
changes.

If EFT payment has been entered, the Processing Payment Verification screen will appear showing the

payment information.

> If everything is correct, select the Yes button.

» To change the information, select the No button and return to the Report Summary screen to make
changes.

The Select EDI File to Create screen will appear, with a highlighted system-generated file name. The file

name may be changed but the file extension type must remain a Text Document (.txt).

Select the Save button.

The following message will appear: “EDI file saved as”...and the location the file was saved. The location

the file is based on the computer’s operating system.

»  Windows Vista, Windows 7, and Windows 8 saves in C:\ProgramData\TexasCPA\Petro40

Select the OK button.

Once a return is processed it will only be viewable by choosing the Processed radio button in the Data

Filter box.

+» Enveloping Multiple Returns

1
2

3
4
5

Select the Processed radio button from the Data Filter box to the bottom right of the Report Index screen.
Highlight all returns to be enveloped by holding down the Control key on the keyboard and selecting each
file to be enveloped.

Select the Envelope button.

Select the Save button on the Select Envelope EDI file screen.

Select the OK button in the Envelope EDI File Saved As screen. The file name will appear in the Envelope
Filename column.
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X111 Registering and Enrolling to File EDI Returns

This section provides instructions for registering and enrolling for EDI filing. To receive approval to file electronically
an initial test return must be submitted for each taxpayer. After processing your return and creating the EDI file follow
the instructions below. Warning! Submitting a Test file is not considered submission of your return/payment. You
must upload a Production file for a return to process to your account. See section XI How to Transmit a Production File
to the Comptroller’s Office.

Registration Information

Please enter the following registration information to access the Electronic Data Interchange System.

Taxpayer Number: | | (11 dicits, no hyphens)
Tax Type

WebFile Number: [ | (8-13 Alphamumeric characters)

Contact Last Name: | |
Contact First Name: | |
Daytime telephone: | DI - | | Ext. | | (option)
E-mail Address: | |
(Confirmation emails will be sent to this address)
1 Go to https://mycpa.cpa.state.tx.us/ediweb/welcomeAction.do?action=agreement.

N

Select the Continue button.

3 Enter data in the following fields:

Taxpayer Number: Enter the 11 digit Texas taxpayer number with no hyphens.

Tax Type: Select the Tax Type drop-down button and choose the appropriate tax type.
WebFile Number: Enter the 8 digit WebFile number starting with RT.

Contact Last Name: Enter the primary contact’s last name.

Contact First Name: Confirmation Enter the primary contact’s first name.

Daytime Telephone: Confirmation Enter the primary contact’s phone number.

E-mail Address: Enter the primary contact’s email address.

e Confirmation emails will be sent to this email address.

Select the Continue button.

Create an alpha-numeric Personal Identification Number (PIN) from 8 to 13 characters in length.
Re-enter your PIN for verification.

Create a Reminder Phrase.

Select the Continue button. The Client Information screen will appear.

YVVVYVYYVYYVY

co~NO O &~
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9 Enter data in the following fields for the taxpayer you are submitting a test file for:
» Taxpayer Number: Enter the 11 digit Texas taxpayer number with no hyphens.
» WebFile Number: Enter the 8 digit WebFile number starting with RT.

10 Select the Add button.

11 Highlight the taxpayer number in the Taxpayer List field.

12 Select the Continue button. If you are testing for more than one account, you must add the additional
taxpayer numbers and WebFile numbers.

13 The Test File Upload dialogue box will appear.

14 Select the Browse button.

HELP INDEX CONTACT Us EXIT Electromic Data Interchange

Electronic File your Texas Tax Retum online!
Data
Interchange

Page Hebp
Test File Upload

Browse and choose the file to upload: Browse.

Click the sbrit bution only once and wait to receive a confimation message before exiting the app lcation.

15 Navigate to the return that was processed previously. The location the file is located is based on your
operating system.
» Windows Vista, 7, and 8 saves in C:\ProgramData\TexasCPA\Petro40
» Windows XP saves in C:\Documents and Settings\All Users\TexasCPA\Petro40

16 Select the Submit button. Your confirmation number will appear on the Test Upload Confirmation page.
» Fail: Read the attachment, correct errors and resubmit file
» Pass: Test file was submitted successfully; you may submit a production file.

17 Select the Exit Electronic Data Interchange button. You must log back in once you have received the
email indicating your test file has passed status.

18 Check your email for a confirmation of enrollment. The status must say “Passed”.

19 Continue to the section XII Transmitting a Production File to the Comptroller’s Office.
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XIV  Transmitting a Production File to the Comptroller’s Office

This section covers transmitting a Production file. A Production file may only be submitted after you register and
enrolled to file electronically through EDI.

HELD TN CONTACT 1 EXIT Eleotronk Tt Tk

lLogin Information

1 After processing a return you will be asked you will be asked Send to the Comptroller now? If you select
Yes your browser will open. Proceed to step 6.

2 If you did not transmit the return at the time it was processed, select the Report button.

3 Select the Processed radio button from the Data Filter box to the bottom right of the Report Index screen.

4 Select the Transmit button. Your browser will open to the EDI Website.

5 If you have not already registered please see the section X How to Register and Enroll to File EDI Returns.

6 Enter Taxpayer Number and Personal Identification Number (PIN).

7 Select the Crude Oil or Natural Gas tax type.

8 Select the Continue button.

9 Review the Registration Information screen.

10 Select the Continue button if taxpayer information is correct.

11 Select the Production File radio button.

12 Select the Continue button.

13 Select the Browse button.

14 Navigate to the return that was processed previously. The default location the file is located is based on your
operating system or where you chose:
» Windows Vista, 7, and 8 saves in C:\ProgramData\TexasCPA\Petro40
» Windows XP saves in C:\Documents and Settings\All Users\TexasCPA\Petro40

15 Select the Open button.

16 Select the Submit button.

17 Record your confirmation number on the Report Index screen. A confirmation email will be sent with
details of Pass/Fail status of the file:
» Pass: No action required.
» Fail: Read the attachment, correct errors, and resubmit the file.
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XV  Modifying and Refreshing a Database

+ Modify Database Path

Modifying the database path will allow the software to read the database information saved to a different location. The
original installed location for the petro40.db file is as follows:

OO WN B

\l

e Windows 7 and 8 - C:\ProgramDATA\TexasCPA\petro40\petro40.db
e Windows XP - C:\Documents and Settings\Allusers\TexasCPA\Petro40\Petro40.db
Select the Tools.
Select Modify Database Path.
Enter the new location for the database file.
Select the OK button.
Close program and restart for the change to take effect.
The software must be installed on the hard drive of each machine accessing the database.
» The software is designed and tested to run with the database saved on the hard drive of a PC.
» The database file can be located on any drive path accessible by the user(s) including network drives.
e Limited technical assistance is available if you choose to run the program on a network.
The database can only be accessed by one user at a time.
The database path is actually stored in configuration file Petro.ini under section [Database file], key
FilePath=.
» Hint: Do not mistake section [Database file] with section [database].

+» Refresh Database

Warning! Do not select Refresh Database unless you want to delete all setups and returns from the software. Selecting
'Refresh Database' will empty all data from the current database and replace it with an empty database. The database
file will be copied and saved with a different name so it can be recovered if necessary.

A WD

Warning! This process will empty out all data from the database and start out new.

Note: The database file will be copied to the following backup file and therefore can
be recovered if necessary:

IC:'\,ProgramData\TexasCPA\PetrD40\201 50311162412 .db

0].8 | Cloze

Select Tools

Select Refresh Database

Refresh Database screen will appear.
Select the OK button.
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XVI Transferring Information to a New Computer

This section provides instructions to transfer the information entered in the Crude Oil and Natural Gas Tax Electronic
Data Interchange (EDI) free software from one computer to another computer. This section covers upgrading a
database form a prior version of the software and moving a database. \Warning! Please save a copy of your database to
your desktop before upgrading the software. The file type should be DB file or Database file.

% Upgrading Before Moving a Database

N

Download and install the Crude Oil and Natural Gas Tax Electronic Data Interchange (EDI) free software
on both computers using the instructions from section 111 How to Download and Install Crude Oil and
Natural Gas Tax Software.

Double click on the Crude Oil and Natural Gas Tax EDI shortcut on your desktop.

Continue to the next section Moving a Database. If you are unable to upgrade please email
EDI.Help@CPA.Texas.Gov for further assistance.

% Moving a Database

o o1~

Close the Crude Oil and Natural Gas Tax Electronic Data Interchange (EDI) free software on both
computers.

Locate your database. The file name is Petro40.db. If you do not see the extensions types look at the file
type. The file type should be DB file or Database file.

The default locations for this file are:

» Windows Vista, 7, and 8 saves in C:\ProgramData\TexasCPA\Petro40

»  Windows XP saves in C:\Documents and Settings\All Users\TexasCPA\Petro40

Copy the database to a portable drive or attach it to an email.

Transfer the databases to correct folder for the new computer.

Open the Crude Oil and Natural Gas Tax Electronic Data Interchange (EDI) free software on your new
compulter.

Review the software for the data that existed in your old computer.
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Help

petrofullV4l exefile

icon

Mext
Finish
PETRCO ETF Shortcut

Taxpaver

MNew

Save

Envelope
Transmit

Yes, login
No, register
Continue
Browse
Open
Submit
Add

Exit

Close

XVII Button and Icon Legend

Use this button to open the software help

Us«e this icon to install the Petro Software

Use this button to go the next step
Use this button to finish the current process

Use this desktop shortcut to open the Motor Fuels
‘Software from the computer desktop

Us«ad to open the Taxpayer window
Used to create a new item

Used to save progress

Laas«a Information

Usad to add or update a lease.

Used to approve the prompt

Used to go to the Other Party list
Tsed to Delete a record

Use to go to the Report List Window
Uﬂed to Process renurns once complete
éSeiects Yes

Belects No

Combines different processed retumns into one file for
submission]

Used to navigate to the Comptroller EDI website to
upload files

Used to Login

Usead to Register

Used to Continue

Used to browse

Us«ed to open a file

Used to submit a file
Us«ed to add
Used to Exit

Usad to Close the Convert Database window

Texas Comptroller of Public Accounts
Electronic Reporting Section
https://comptroller.texas.qov/taxes/file-pay/edi/
1-800-442-3453
Publication #96-998, Revised 2016
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